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Введение в OpenEdge Architect

Рабочие области, проекты и ресурсы

Старт и создание Вашей первой рабочей области

При первом запуске OpenEdge Architect Вам будет предложено указать рабочую область.
После чего будет открыто окно приветствия, содержащее ссылки на ресурсы и
дополнительную информацию относительно среды разработки OpenEdge. В этом
упражнении мы запустим Architect и создадим первую рабочую область.

1. Выберите иконку OpenEdge Architect из меню “Start”

2. После запуска, Вам будет предложено создать рабочую область. Введите
“C:\OpenEdge\WRK\myFirstWorkspace” вместо предложенной рабочей области по
умолчанию. Мы будем использовать эту директорию в качестве рабочей области
наших проектов.
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Примечание: Когда Вы создаёте рабочую область, помните, что Architect чувствителен к
регистру. Т.е. если будет введено нечто вроде “C:\OpenEdge\wrk\myFirstWorkspace”, где
каталог “wrk” должен быть на самом деле в верхнем регистре, Architect даст Вам это сделать
и продолжит работу, но у Вас возникнут сложности в будущем с рабочей областью и
проектом связанным с ней, поскольку Architect не сможет правильно найти этот каталог.

3. Далее будет открыто окно приветствия, содержащее ссылки на дополнительные
материалы, имеющие отношение к OpenEdge Architect и другим OpenEdge продуктам.
Просто щелкните на иконке “Go to Workbench” в правом верхнем углу экрана.

Вы можете в любое время вернуться в окно приветствия, выбрав в меню Help -> Welcome.
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Либо выбрать иконку “Return to Welcome” (если окно приветствия не было закрыто),
расположенную в левом нижнем углу экрана.

4. Теперь Вы перешли к основному экрану Architect – Main Screen. Поздравляем, Вы
успешно запустили Architect и создали свою первую рабочую область.

Создание проекта

Создания проекта – простой процесс. Процесс создания происходит с помощью
специального окна, которое поможет настроить Ваш проект. Architect автоматически
настроит структуру проекта и создаст директории для его хранения.

1. Для создания нового проекта выберите в меню File -> New -> Project.

Или щелкните стрелку около кнопки “New” в меню и выберите опцию “Project”.
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2. После чего будет отображен экран, в котором можно выбрать тип создаваемого
проекта. Выбор типа проекта определяет, какой тип Wizard`а будет запущен для
завершения процесса. Для создания проекта раскройте папку OpenEdge и выделите
“OpenEdge Project”. Щелкните на кнопке “Next”.
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3. Следующий экран позволяет ввести имя проекта, которое необходимо ввести в поле
“Project Name”. По умолчанию, Architect создает директорию проекта в текущей
рабочей области, используя имя проекта введенное Вами. Если Вы хотите хранить
файлы проекта в директории, отличной от предложенной по умолчанию, необходимо
отменить опцию “Use Default” и ввести свой вариант. Для этого упражнения
используйте директорию по умолчанию. Щелкните копку “Next”.
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4. Architect начнет процесс создания нового проекта. Будет выведен экран с вопросом о
необходимости связать проект с OpenEdge Editor Perspective. Выберите кнопку “Yes”.
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5. Теперь процесс создания нового проекта завершен. Сообщения о создании проекта и
его статус будет отображен в Console View. Позже мы подробнее остановимся на
деталях проекта, ну а пока необходимо рассмотреть управление Architect`ом и
научиться понимать его сообщения.

Создание вашего первого ресурса

Исходный код ABL, содержащий синтаксис интерфейса пользователя и бизнес ABL,
наиболее распространенный файловый ресурс, используемый в проекте. Этот тип
автоматически связывается с OpenEdge Editor`ом. В этом упражнении Вы создадите Ваш
первый файловый ресурс исходного кода ABL.

1. Создайте новый файл, щелкнув стрелку около кнопки “New” и выбрав опцию “File”.
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Создать новый файл можно также из меню опций File -> New -> File.

2. В диалоговом окне “New File” можно изменить директорию файла, заданную по
умолчанию, а также дать имя новому файлу. Для данного примера, оставьте
директорию по умолчанию, myFirstProject, и присвойте имя файлу –
“myFirstProgramm.p”. Щелкните на “Finish” для продолжения.
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3. Теперь Architect создаст файл и откроет его с помощью OpenEdge Editor.

4. Введите следующий синтаксический код, используя OpenEdge Editor View

5. Когда Вы измените текст, перед названием файл в View Tab появится звездочка (*).
Это означает, что после последнего сохранения файла, в нем произошли изменения.
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Чтобы сохранить файл, выберите кнопку “Save”, либо используйте меню File -> Save

Это завершающий процесс для создания файла исходного кода.

Выполнение кода в режиме GUI

Architect может создавать и тестировать код ABL в следующих средах – GUI, Character и Web
. GUI режим - режим по умолчанию, используемый Architect. Следующим нашим шагом
будет тестирование нашего кода в GUI режиме.

1. Выберите кнопку “Run” в Main-меню.

2. Вы увидите результат выполнения программы в GUI режиме в виде слова “Hello
World” в верхнем углу. Нажмите пробел для завершения работы программы.
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Выполнение кода в режиме CHUI

Вы также можете запустить Вашу программу в Character – режиме.

1. Выберите стрелку около кнопки “Run”

2. В раскрывшемся меню выберите “Run as TTY application”



OpenEdge Architect ÓБашкатов В.Г. 2008 г.

Учебное пособие (источник www.openedge.ru) стр. 14 из 94

3. Символьный экран отобразит следующий результат.

Нажмите пробел для закрытия окна

4. Закройте myFirstProgramm.p файл.
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Импорт исходного кода в проект

Architect умеет импортировать код, созданный как другими проектами, так и код созданный в
среде, отличной от среды Architect. Для того чтобы найти исходный код для нашего проекта,
сделаем следующее:

1. Щелкните правой кнопкой мыши на myFirstProject в Resource View и выберите опцию
Import. Так же можно использовать опцию File -> Import в меню Main

2. Запустится Wizard импорта. В первом окне для импорта выберите тип ресурса “File
System”. Щелкните кнопку “Next” для продолжения.



OpenEdge Architect ÓБашкатов В.Г. 2008 г.

Учебное пособие (источник www.openedge.ru) стр. 16 из 94

3. В поле “From Directory” введите директорию с исходным кодом. Вы также можете
использовать кнопку “Browse” для поиска.

4. Разверните папку “Resources” и щелкните кнопку “Select All”. Все директории и
файлы, находящиеся в папке “Resources” будут помечены для импорта в проект. Сама
же директория “Resources” импортирована не будет. Щелкните кнопку “Finish”.
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5. В окне Resources View теперь Вы можете увидеть импортированный файлы и
директории. Раскройте одну из импортированных директорий, и вы увидите файлы,
импортированные вместе с ней.
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OpenEdge ABL и OpenEdge Editor

Подключение Базы Данных к проекту

Соединение ABL Application и Базы Данных

Прежде, чем начать программировать ABL-код для доступа к базе данных, необходимо
сначала определить набор свойств, позволяющих проекту подсоединяться к ней. Для
создания соединения проекта myFirstProject с базой autoEdge выполним следующее.

1. Убедитесь, что открыт редактор OpenEdge Editor Perspective.

2. Правой кнопкой мыши кликните на пункте myFirstProject в обозревателе Resources и
выберите опцию Properties.
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3. С левой стороны окна Properties выберите пункт OpenEdge, вкладку Connection.
Нажмите кнопку Add.

4. В окне New Connection в поле Name наберите “autoEdge”, в поле Connection – “-db
autoedge –H localhost –S 10001”, нажмите кнопку Test Connection.

5. В случае успешного соединения должно появиться диалоговое окно Connection: OK.
Нажмите кнопку OK.
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6. Теперь в окне New Connection для завершения создания соединения кликните OK.

7. В окне Properties появилось созданное новое соединение, отобразившееся в браузере.
Нажмите OK.

8. Выберите вкладку Databases следующую за вкладкой Outline. Данный обозреватель в
режиме чтения отображает схему базы данных. Разверните пункты AUTOEDGE ->
Customer. Как вы и убедились, эту вкладку можно использовать для быстрого
просмотра таблиц и их полей, определенных в базе данных.
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Использование вспомогательных функций кода OpenEdge Editor

Исследование особенностей редактора OpenEdge Editor

В данном разделе вы научитесь составлять ABL код для доступа и вывода на экран
информации, содержащейся в базе данных, на примере базы autoEdge, используя для
редактирования вспомогательные возможности OpenEdge Editor Architect. Код будет
находить и выводить на экран список имен покупателей и их дней рождений из базы
autoEdge.

Создание нового файла с использованием File Template

File Template обеспечивает быстрый и легкий путь разработки кода на основе шаблона.
Используем File Template для написания процедуры, сделав следующее.

1. В Resources View кликните по myFirstProject.

2. Выберите через стрелку возле кнопки New опцию Other.
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3. В окне Wizards разверните пункты OpenEdge -> Editor и выберите Custom Procedure
File. Нажмите кнопку Next.

4. В открывшемся окне измените значение поля File Name на “myCustom.p” и дайте
описание в поле Description, как показано ниже. Нажмите кнопку Finish.
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5. В OpenEdge Editor открылась программа myCustom.p. Обратите внимание - как в
новом программном файле была размещена информация, которой заполнялось окно
мастера Wizard .
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6. Кликните дважды по названию программы myCustom.p в редакторе. Редактор
развернется на весь экран и займет всю площадь видимой области. Чем больше виден
текст кода, тем легче становится процесс его написания.

Использование Section Creators для создания фрагментов кода

Section Creators позволяет быстро создавать стандартные фрагменты кода, такие как
функциональный или процедурный блок. В файле myCustom.p организуем функцию, которая
бы объединяла две строки в одну с пробелом между ними. Данная функция будет
использоваться при получении ФИО работников, составленного из полей First Name и Last
Name.

1. Правой кнопкой мыши щелкните в поле окна редактора и в появившемся меню
выберите Source -> Add Function option.
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2. В окне мастера Function Definition наберите “concatStrings” в поле Name. Оставив
остальные значения полей по умолчанию, нажмите OK.

3. Созданный новый фрагмент кода функции приведен ниже.
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Просмотрите, как Section Creator использовал информацию из мастера Function
Definition при автоматической генерации кода. Обратите внимание, созданы
поименованные раздел объявления функции Function Prototype и, содержащий
текущий код, Function Implementation, которые располагаются вокруг Main Block.

4. Добавьте следующий код для функции как показано ниже.
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Использование Code Templates для написания кода

Code Templates предусматривают макросы для быстрого добавления в программный код
общих синтаксических выражений. Используем их для определения переменных в программе
myCustom.p, выполнив следующее.

1. В разделе Definitions кода программы myCustom.p наберем “dvch”.
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2. Нажмите клавишу пробела. Для вас будет сформирован синтаксис, определяющий
переменную типа character. Введите имя переменной myChar и добавьте после Label и
Format приведенный ниже код.

Установка Auto-Complete Preferences

Авто-заполнение Auto-Complete экономит время разработки программы при завершении
синтаксических выражений, обращениях к базе и взятии в скобки. Опция авто-заполнения
Auto-Completion может быть установлена через Auto-Complete Preferences в Architect.
Привилегия авто-заполнения доступна по умолчанию для расширения таблиц баз данных
и имен полей. Однако не существует привилегии для расширения зарезервированных
слов. Для обращения к Preference выполните следующее.

1. Откройте Window -> Preferences Main Menu option, выберите пункты OpenEgde ->
Editor -> Formatting. Проверьте наличие выбора опции Expand keywords, нажмите
копку OK.
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Использование Auto-Complete

В разделе Main Blok программного файла myCustom.p необходимо добавить код, выводящий
на экран все имена покупателей и дни рождения из полей Customer Name и Dates of Birth.
Ускорим этот процесс, используя некоторые свойства Auto-Complete и Auto-Format.

1. В Main Block наберем “for each cus”. Обратите внимание, каким шрифтом было
выведено зарезервированное слово и, как изменился цвет “cus” после набора
последнего символа “s”. Architect распознал этот частичный код, как
соответствующий имени базы данных.
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2. Нажмите клавишу пробела для автоматической вставки имени базы “customer”.
Завершите код выражением “no-lock” и нажмите Enter или клавишу возврата.

3. Напечатайте “myChar = concatStrings(”. Обратите внимание, Architect самостоятельно
закрыл (в данном случае простые) скобки.
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4. Напишите “cus.customerf<space>, cus.customerl<space>”. Убедитесь, что после “f” и “l”
поставлены пробелы и запятая между двумя выводимыми полями. Architect расширит
текст для имени полей как показано ниже. Поставьте точку в конце выражения и
нажмите клавишу Enter.

5. Наберите “disp” и нажмите пробел. Architect завершит написание зарезервированного
слова, в соответствии с принятым синтаксисом.
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Использование всплывающего списка Pop-up Pick List и поддержки Syntax
Help

Pick Lists – это всплывающий список синтаксических выражений, являющихся возможными
продолжениями частично набранного кода. Pick List реагирует как на зарезервированные
слова, так и на имена полей базы данных, причем вместе с ним также выводится на экран
Pop-up Syntax Help, описывающая предлагаемые варианты выбора.

Использование Auto-Complete

Для завершения вывода на экран имен покупателей и дней рождения выполним следующее.

1. В редакторе установим курсор после оператора Display и через пробел добавим
“myChar” и “cus.” (Architect самостоятельно допишет название имени таблицы
“Customer”). Подождите немного, пока появится список выбора по базе данных
Database Schema Pick List (его вызов возможен также нажатием клавиш CTRL +
SPACE). Найдите в нем поле Customer.CustomerBirthdate, нажмите клавишу Enter.
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2. Поставьте точку по завершении строки и нажмите Enter.
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3. Установите курсор в начало следующей строки. Наберите “en” и нажмите Ctrl + Space
чтобы появился список выбора зарезервированных выражений Keyword Pick List.
Найдите в нем END и нажмите Enter, чтобы применить выражение. Завершите стоку
точкой.
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Синтаксическая проверка, сохранение и запуск программы

Для завершения и проверки программы выполним следующее.

1. Щелкните правой кнопкой мыши в поле редактора и, в появившемся меню, выберите
опцию проверки ошибок Check Syntax, чтобы убедиться в их отсутствии.
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2. В диалоговом окне проверки синтаксиса Syntax Check нажмите OK.

3. Сохраните и запустите файл. Полученный результат выглядит примерно следующим
образом.



OpenEdge Architect ÓБашкатов В.Г 2008 г.

Учебное пособие стр. 38 из 94

4. Кликнув дважды в редакторе по метке с названием выполняемой программы, вернем
ему первоначальный стандартный размер.



OpenEdge Architect ÓБашкатов В.Г. 2008 г.

Учебное пособие стр. 39 из 94

OpenEdge Database и Database Navigator

Создание новой базы данных

Использование Database Navigator для создания базы данных

OpenEdge упрощает создание и поддержку баз данных и их схем. Следующие шаги
продемонстрируют, как создать новую базу с помощью Database Navigator.

1. Откройте Database Navigator Perspective через Window -> Open Perspective -> Other
option. Выберите из списка OpenEdge DB Navigator и нажмите OK.

2. Для создания базы данных, выберите кнопку Create Database на панели инструментов
обозревателя Connections.
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3. В поле New Physical Database Name наберите “C:\OpenEdge\WRK\autoedge.db”

4. Выберите опцию копирования какой-либо базы “A copy of some other database” в
области “Start With”. В поле, предоставленном для создания копии базы, наберите
“C:\OpenEdge\WRK\Tour\TryIt\Database\autoedge.db”, либо найдите базу AutoEdge,
используя для этого кнопку Files. Нажмите OK.
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5. Когда процесс будет завершен, вы получите сообщение об успешности создания базы
данных. Нажмите OK.

6. Содержимое обозревателя Database Navigator не изменилось после выполненных
действий. Это связано с тем, что сначала необходимо запустить сервер для новой
созданной базы, чтобы далее соединиться с ней и использовать другие возможности
Navigator (это будет сделано в следующем примере). Однако, вы можете убедиться,
что база действительно была создана, открыв рабочую директорию
C:\OpenEdge\WRK. В ней вы увидите файлы базы данных AutoEdge, как приведено
ниже.



OpenEdge Architect ÓБашкатов В.Г. 2008 г.

Учебное пособие стр. 42 из 94

Настройка и запуск сервера базы данных

Конфигурирование сервера базы данных

Изначально, соединение базы данных с Database Navigator – многоступенчатый процесс.
Сначала, необходимо сконфигурировать сервер для базы, а затем уже запускать на нем
процессы, использующие определенную информацию конфигурации. Далее понадобится
создать профайл соединения Connection Profile в навигаторе Database Navigator, чтобы
последнему стал доступен сервер базы данных Database Server. В конечном итоге именно
Connection Profile будет использоваться для соединения с сервером.

Повторять шаги по конфигурированию Database Server и созданию Connection Profile при
последующих соединениях с базой данных нет необходимости, т.к. настройки сохраняются
для их дальнейшего использования. Но при этом понадобится запускать Database Server и
Connection Profile каждый раз при очередных соединениях. Настройки, необходимые для
Database Server и Connection Profile, запускаются автоматически и будут рассмотрены
детально при их пошаговой ручной установке.

Выполните следующие шаги, чтобы сконфигурировать Database Server для базы данных
AutoEdge, созданной ранее.

1. Через меню Start откройте Progress Explorer tool.
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2. Для создания Database Server, сначала потребуется соединиться с административным
сервером Administration Server, который уже запущен как приложение. Если
существуют какие-либо трудности с соединением, проверьте его наличие в Service
Administration tool для Windows.

Кликните правой кнопкой мыши по пункту Progress Explorer и выберите опцию Add
Progress Server.

3. Появилось окно свойств Server Properties, в котором в поле Server указано значение
“localhost”, в поле User – логин Вашего компьютера. Выберите опцию
переподключения при запуске Reconnect at Startup, чтобы каждый раз при старте



OpenEdge Architect ÓБашкатов В.Г. 2008 г.

Учебное пособие стр. 44 из 94

Progress Explorer Tool прежде устанавливалось соединение с Administration Server.
Нажмите OK.

4. Сформирован Administrative Server названный “localhost”. Правой кнопкой мыши
кликните по пункту “localhost” и выберите опцию Connect.

5. Открылось окно Login, где в поле User указан логин компьютера. Не изменяя данного
значения и не заполняя поле Password, нажмите кнопку OK.
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Подключившись таким образом, вы соединитесь с Administration Server, не задействовав
логин и пароль. Если вы используете конфигурацию по-умолчанию, заполнение полей User и
Password не обязательно. Если в течение процесса инсталляции продукта данная опция
безопасности была задействована, в дальнейшем для соединения с Administration Server
необходимо будет использовать примененные вами значения (обычно совпадающие с
логином и паролем для доступа к компьютеру). Вы можете также установить данные
значения, вернувшись в окно Server Properties (пункт 3), и сохранить их для будущего
использования.

6. Если соединение с Administration Server произошло успешно, localhost заполнится
новым содержимым. Правой кнопкой мыши щелкните по пункту Databases и выберите
опцию New для создания нового сервера Database Server.

7. Наберите в поле Name название сервера базы данных AutoEdge, нажмите OK.
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8. В окне свойств Database Properties, наберите “C:\OpenEdge\WRK\autoedge.db” в поле
для выбора пути и названия базы данных path and filename of the database. Выберите
опцию “Automatically Start this Database when the Admin Server is Started”. Эта опция
запускает сервер базы данных Database Server при очередном старте Administration
Server. Нажмите OK.

9. Созданный сервер базы данных отразился ниже пункта Database. Далее необходимо
установить свойства группы сервера Server Group Properties. Разверните следующие
пункты Database -> AutoEdge -> Configuration -> defaultConfiguration. Щелкните
правой кнопкой мыши по defaultServerGroup и выберите опцию Properties.
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10. Убедитесь, что в разделе тип клиента Client Type появившегося окна Server Group
Properties выбрана опция “Both 4GL and SQL” . Она позволит базе данных
присоединяться как с помощью ABL, так и SQL инструмента. Установите в поле
“Service Name or Port Number” значение 10001 или любое другое, являющееся
неиспользуемым номером порта. Список зарезервированных номеров портов
компьютера можно найти в служебном файле, который обычно располагается на
“C:\WINDOWS\system32\drivers\etc”. После завершения нажмите OK.
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Запуск сервера базы данных

Теперь, после конфигурации Database Server, возможен его ручной запуск. Если же Database
Server был установлен с учетом автоматического подключения (см. пункт 6), необходимость
запускать его вручную после первого раза исчезает.

1. Выберите пункты Databases -> AutoEdge и нажмите зеленую кнопку запуска Start на
панели инструментов.
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2. После запуска Database Server кнопка Start сменится кнопкой Stop (красный круг с
надписью “X”). Вы можете также удостовериться, что сервер запущен, нажав на
кнопку состояния Status (синий круг с буквой “i”).

Если соединение успешно, в окне Status будет запись Running.
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3. Выполнив все действия, закройте окно Progress Explorer Tool.

Соединение Database Navigator с базой данных

Соединение Database Navigator с сервером Database Server

После создания и запуска Database Server необходимо установить соединение, т.е.
сконфигурировать Database Navigator для организации доступа к базе данных. Для этого
потребуется сформировать Connection Profile базы. Выполните следующие шаги для
соединения Database Navigator с AutoEdge Database Server, используя Connection Profile.

1. Правой кнопкой мыши кликните по пункту Connection Profiles в окне соединений
Connections. Выберите опцию создания профайла Create Connection Profile.
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2. Заполните поля Name, Host, Port, Database как указано ниже. Также выберите опцию
“Open on Eclipse Startup”. Она позволяет автоматически устанавливать соединение с
базой данных при каждом запуске Architect. Завершив действия, нажмите кнопку OK.

Примечание: Вы можете ввести данные об имени пользователя и пароле для
соединения с базой данных в поля User Name и Password, Architect сохранит их.
Однако данная информация не зашифровывается, поэтому вы можете отказаться от
хранения таких данных здесь.

3. По-окончании последнего шага, ниже Connection Profiles появится пункт AutoEdge
DB. Кликните дважды по нему, чтобы установить соединение с базой autoEdge. Вам
необходимо будет повторять этот и следующие шаги каждый раз при соединении с
базой данных, кроме случая, если в профайле Profile (см. пункт 2) было указано
автоматическое подключение.
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4. Перед завершением процесса, вам будет предложено соединиться с базой, подтвердив
комбинацию имени пользователя и пароля, в окне, напоминавшем ранее о
возможности внесения этих данных без их дальнейшего сохранения в Architect.

Т.к. вы только что создали базу данных, подтверждение логина отключено по-
умолчанию. Для SQL-соединения все же требуется имя пользователя, даже если у него
не существует соответствующей учетной записи в базе. Вы можете набрать любое имя
пользователя, оставив пароль пустым, чтобы соединиться с базой данных для
просмотра ее схемы.

Однако для изменения схемы базы потребуется соблюдение правил безопасности
DBA. Как правило, при создании базы учетная запись SQL DBA создается
автоматически, по-умолчанию используя название компьютера. Но у данной базы есть
свое User Name.

Используйте User Name “touruser” и пустой пароль для подключения к базе данных
autoEdge. По-завершении нажмите OK.
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5. Если соединение произошло успешно, ниже Active Session вы увидите пункт
“AutoEdge DB”. Информативное окно Info Connection будет также заполнено данными
про базу и ее подключение.



OpenEdge Architect ÓБашкатов В.Г. 2008 г.

Учебное пособие стр. 54 из 94

Исследование и модификация схемы базы данных

Исследование схемы базы данных

Database Navigator облегчает просмотр и внесение изменений в схему базы данных. Чтобы
использовать Navigator для изучения табличной схемы базы AutoEdge, выполните
следующее.

1. В окне DB Structure для AutoEdge DB раскройте пункты Database -> Pub -> Table.
Проверьте, что в окне отразились 9 содержащихся в базе таблиц.
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2. Выберите пункт Customer. При этом в окне детализации DB Details отобразится
информация о таблице Customer.

3. В окне DB Details с помощью левой стрелки прокрутки найдите вкладку Preview.
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4. Выберите вкладку Preview. В ней отражаются текущие данные из таблицы базы.

Модификация схемы базы данных

Чтобы использовать Navigator для изменения схемы базы AutoEdge и добавления в нее новой
таблицы с полями и индексами, выполните следующее.

1. В окне DB Structure правой кнопкой мыши кликните по любой из таблиц,
находящихся под пунктом Table и в появившемся меню выберите опцию добавления
Add Table.
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2. Для добавления таблицы будет вызван соответствующий мастер. В открывшемся окне
Add Table наберите “myTable” в поле имени таблицы Table Name. Нажмите кнопку
Next для продолжения.

3. В следующем окне поля Name наберите myFirstColumn. Оставьте остальные поля
заполненными по-умолчанию и нажмите кнопку Add для добавления поля.



OpenEdge Architect ÓБашкатов В.Г. 2008 г.

Учебное пособие стр. 58 из 94

4. В поле Name измените New_Coloumn на значение mySecondColumn и тип с Data Type
– на Integer. Нажмите Next.

5. В открывшемся окне в поле Name наберите “myPrimaryIndex”. Выберите поле
“myFirstColumn” и добавьте его из списка “Select fields to add to Index” в список “Fields
of the New Index”, нажав на правую стрелку. Завершите действия кнопкой Finish.
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6. Таблица добавлена в базу, в окне DB Structure появился новый пункт myTable.

7. Раскройте новый пункт myTable, а также пункты полей и индексов, содержащихся в
нем. Вы увидите добавленные вами новые элементы схемы.
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8. Закройте Database Navigator Perspective, нажав правой кнопкой мыши по метке с
названием окна на панели инструментов и выбрав опцию Close из контекстного меню.
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Программа отладки: OpenEdge Debugger

Настройка среды отладки

Разблокирование функции отладки

Функции отладки не доступны по-умолчанию. В среде OpenEdge их потребуется
принудительно установить, выполнив следующее.

1. Закройте OpenEdge Architect.

2. Выберите из меню Start опции Progress->OpenEdge->Proenv.
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3. В командной строке Proenv наберите “prodebugenable –enable-all”. Нажмите клавишу
Enter. В OpenEdge станут доступными функции отладки.

4. Наберите “exit” и нажмите Enter для закрытия среды Proenv.

5. Откройте снова OpenEdge Architect. Если потребовалось объявить рабочую область
Workspace, оставьте значение по умолчанию и нажмите кнопку OK.

Сохранение и генерация R-кода

R-код – это компилированный файл ABL программы, он должен быть доступным для
Debugger до начала процесса отладки. Каждый раз при сохранении программы Architect
автоматически выстраивает R-код файл для нее. Следующие шаги описывают как установить
эту опцию и сгенерировать r-код для файлов проекта, которые уже созданы и сохранены.

1. Чтобы сделать доступной опцию R-code Save/Reference Tracking, выберите
Project >Properties Main Menu. В окне свойств Properties слева перейдите на OpenEdge,
справа – на вкладку Build. Отметьте опцию Save r-code, нажмите кнопку OK.
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2. Для создания r-кода для уже существующей программы, кликните правой кнопкой
мыши по пункту myFirstProject в окне Resources и выберите OpenEdge -> Compile.
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3. По окончании компиляции сформируется список сообщений в окне Console
указывающий на обработанные программы. Проигнорируйте ошибки, которые могли
возникнуть в процессе компиляции, так как необходимо прежде завершить процесс
написания кода для некоторых программ проекта.
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Отладка ABL приложения

Использование отладчика Debugger

Для проверки функций Architect Debugger на примере программы myCustom.p выполните
следующее.

1. Программа myCustom.p все еще должна быть открыта в редакторе OpenEdge Editor. В
ином случае, кликните дважды по myCustom.p ниже пункта myFirstProject в окне
Resources.

2. Правой кнопкой мыши кликните по Overview Ruler и выберите опцию Show Line
Numbers. Это упростит нахождение кода при отладке.

3. Кликните дважды по Overview Ruler, чтобы переместить точки прерывания на линии
31 и 32 как указано ниже. Убедитесь, чтобы синтаксис линий на рисунке совпадал с
вашим. Иначе, запустите маркеры, начиная с кода “cFullName = concatStrings”.
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4. Нажмите кнопку Debug в главном меню.

5. Откроется окно OpenEdge Debugging и начнется исполнение программы.
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6. В окне Variables вы увидите переменную myChar с пустым текущим значением.

7. Перейдите к окну Buffer. Обратите внимание, что буфер Customer был сформирован,
ссылаясь на буфер, использовавшийся в операторе For Each на линии 30.
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8. Перейдите на вкладку Breakpoints. Вы увидите две контрольные точки, определенные
в списке.

9. Вернитесь на вкладку Variables.

10. Нажмите кнопку Continue в главном меню.

11. Во вкладке Variables появилось значение для myChar.
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12. Нажмите кнопку Continue. Подкрашенная строка отладки - зеленый цвет линии 32 –
указывает на последнюю линию, обработанную отладчиком. Результат применения
оператора Display в линии 32 отразился в окне приложения Progress.
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13. Нажмите кнопку Continue. Отладчик продолжит исполнение и завершит For Each
блок. Он переместит подкрашенную строку на свободное место над кодом, выше
оператора For Each, показывая, что процесс стартует сначала. Зеленый маркер
подсвечивает линию 29 и указывает на начало отлаженного цикла.

14. Кликните дважды по кнопке Step Into.

15. Это позволит вам перейти к коду функции concatString. Проверьте, что в окне Stack
отображаемая функция concatString является следующей по списку.
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16. Перейдите во вкладку Parameters. Вы увидите два значения параметра, которые были
переданы функции concatString.

17. Вернитесь в окно Variables.

18. Нажмите клавишу Step Out для выхода из кода функции.
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19. Убедитесь, что в результате действия функции, значение переменной myChar
изменилось на ожидаемое.

20. Нажмите дважды кнопку Stop для остановки процесса отладки и очищения окна
Results.
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21. Закройте окно OpenEdge Debugging.

22. Закройте файл myCustom.p.
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Инструменты для бизнес-логики

Создание компонентной диаграммы

Создание файла диаграммы и ProDataSet компонента

Выполните следующие шаги для создания файла диаграммы, в которой будет наглядно
представлена информация с помощью ProDataSet компонента о покупателях, тесте по
вождению и машинах.

1. Вызовите Tools for Business Logic Perspective, открыв Window -> Open Perspective ->
Other Main Menu. Далее выберите пункт OpenEdge Tools for Business Logic и нажмите
OK.

2. Так как Tools for Business Logic использует SQL соединение для доступа к схеме базы
данных, убедитесь, что в окне Connection соединение AutoEdge DB активно.
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3. Создайте новый компонент, нажав на стрелку, направленную вниз, возле кнопки New
и выбрав опцию Business Logic Component.

4. В открывшемся окне мастера новых компонентов, установите следующие значения:

· Location: \myFirstProject
· Component Name: dsTestDrive.dgm
· Component Type: ProDataset

Закройте окно, нажав кнопку Finish.
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5. Создан файл диаграммы. Открылось окно, где в области для размещения элементов
дизайна находится ProDataset компонент с названием dsTestDrive.
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Создание временной таблицы с информацией о структуре схемы
базы данных

Существует много случаев, когда создается и повторно используется структура компонентов
диаграммы. Один быстрый способ для создания компонента временной таблицы – это
копирование структуры схемы с уже существующей базы данных. Для создания компонента
временной таблицы диаграммы dsTestDrive с помощью структуры базы данных выполните
следующие действия:

1. В окне DB Structure раскройте пункты Database -> Pub -> Table и найдите таблицу
Customer.

2. Удерживая мышью, переместите таблицу Customer в область для размещения
компонентов. Будет создан новый компонент временной таблицы Customer.

3. Выберите новый компонент временной таблицы Customer и вкладку Properties.
Переместитесь к Name Property ниже пункта Attributes. Кликните по ячейке со
значением Value и измените его на “ttCustomer”.
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4. Вернитесь в окно DB Structure и повторите шаги 2 и 3 для следующих таблиц.

Table Temp-Table Name

TestDrive ttTestDrive

Car ttCar

CarBrand ttCarBrand

CarModel ttCarModel

5. Компоненты временной таблицы на диаграмме располагаются примерно так, как
показано на рисунке ниже. Вы можете развернуть диаграмму для просмотра на всю
видимую область, кликнув дважды по ее названию.
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Добавление связей отношений

Для добавления отношений между компонентами временных таблиц в диаграмме
dsTestDrive, выполните следующее.

1. Откройте палитру Palette, выбрав левую стрелку в правой части области для
размещения компонентов. Обратите внимание, что при наведении мыши на Palette
всплывает надпись раскрытия палитры Show Palette.
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2. В палитре под меткой Connections выберите опцию Two-way Reference.
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3. Наведите стрелку мыши на компонент ttCustomer.
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4. Кликните и протяните линию связи от ttCustomer (источника) к ttTestDrive (конечному
элементу). Будет создано отношение.
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5. Повторите шаг 4 для аналогичного создания отношений между следующими
компонентами:

Источник Конечный элемент

ttTestDrive ttCar

ttCar ttCarBrand

ttCar ttCarModel

6. Диаграмма после установления связей будет выглядеть примерно следующим
образом:
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7. Вернитесь в палитру и выберите опцию Select.

8. Выберите линию связи между ttCustomer и ttTestDrive.
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9. Выберите вкладку Properties. В поле Name впишите “relCust_TestDrive” и нажмите
Enter. Результат отразится на диаграмме. Измените значения для SourceColumn и
TargetColumn на CustomerID. Установится ключевое отношение по столбцу между
двумя компонентами.
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10. Повторите шаги 8 и 9, установив следующие свойства для отношений:

Source->Target Name Source/Target Column

ttTestDrive->ttCar relTestDrive_Car CarID

ttCar->ttCarModel relCar_Model CARModelID

ttCar->ttCarBrand relCar_Brand CarBrandID

11. Компонентная диаграмма теперь завершена и выглядит следующим образом.
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Заблаговременный прикладной код

Так как компонентная диаграмма сформирована, стало возможным использование модели
для генерации ABL кода, базирующегося на структуре и свойствах ее составляющих. Чтобы
сгенерировать код для ProDataSet dsTestDrive, включающего все связанные определения
временных таблиц, выполните следующее.

1. Сохраните диаграмму, нажав на кнопку Save на главной панели инструментов.
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2. Кликните правой кнопкой мыши по области для размещения компонентов и в
появившемся меню выберите опцию создания кода Generate Code.
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3. Подключаемые файлы, содержащие ABL-код, будут созданы для ttCustomer,
ttTestDrive, ttCar, ttCarModel, ttCarBrand, dsTestDrive компонентов. Проверив, закройте
их.
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Интеграция созданного кода в приложение

Использование созданного кода в приложении

Чтобы использовать сгенерированный код как часть приложения, необходимо добавить
ссылку на подключаемый файл в общий код там, где это требуется. Для добавления
компонента dsTestDrive в приложение и его тестирования выполните следующее:

1. Двойным щелчком мыши кликните по программе wAutoEdgeMaint.w в окне Resources
для ее открытия в редакторе Editor.
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2. Переместитесь с помощью полосы прокрутки в раздел Definitions и найдите
комментарий, который определяет место для описания ProDataSet.



OpenEdge Architect ÓБашкатов В.Г. 2008 г.

Учебное пособие стр. 92 из 94

3. Ниже комментария впишите ссылку на подключаемый файл “{dsTestDrive.i}”.

4. Сохраните файл. Запустите программу на исполнение, нажав на кнопку Run в главном
меню.
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5. Появилось окно поддержки TestDrive. Вы можете перемещаться по информации,
поддерживаемой ProDataSet, раскрывая записи, отражаемые в дереве слева и, выбирая
информационные вкладки, справа. Функции поддержки в этом простом окне не
доступны. По-окончании тестирования, закройте окно.
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